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Introduction

About This Document

Purpose

This guide provides a technical guide for localising the MT8001 terminal software. In-
dividuals performing these operations are expected to have prior expertise in the field
of security, at least a moderate level of familiarity with the Siemens Building Tech-
nologies product line, and experience with the installation and configuration of security
management systems.

Scope
This document applies to the MT8001 Management Station, version 4.30.

Target audience
This documentation is intended for the following user:
- Product Managers.

Documentation resource information
The DMS8000 Documentation Resource Information Guide document assembles
in one place important information regarding documentation resources. It contains the
following:

— Comprehensive definitions of the target audiences for FS DMS documents

— Training program information including the Siemens intranet link
— A complete list of all available DMS8000 documents

— Instructions for how to obtain a document via the Siemens intranet using the
STEP Documentation Repository System

- A map of relevant documents for each target audience group
— Customer Support links & resources
— A glossary containing definitions of all terms and acronyms used in DMS8000
documentation
To access the DMS8000 Documentation Resource Information Guide (STEP
#A6Y10089056), go to the link and follow the instructions below:
https://workspace.sbt.siemens.com/content/00001123/default.aspx

1. Click on the STEP WEB Client image: ¢ .

Choose 04 Fire -3F from the Product Segment box and select Activate filter.

3. Select All in the Documents section of the Quick Search page and then
select Advanced Search.

4. Enter the document number in the Brochure No. field (e.g. A6V10089056) and
press Enter.

n

Liability disclaimer for damage or injuries

Before products are delivered, they are tested to ensure they function correctly when
used properly. Siemens disclaims all liability for damage or injuries caused by the in-
correct application of the instructions, or the disregard of danger advisories. This dis-
claimer applies in particular to personal injuries or damage caused by:

— Improper and/or incorrect use.

— Disregard of safety instructions in the documentation or on the product.

— Poor maintenance or a lack of maintenance.

We have checked the contents of this manual for agreement with the hardware and
software described. Since deviations cannot be precluded entirely, we cannot guaran-
tee full agreement. However, the data in this manual are reviewed regularly and any
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necessary corrections included in subsequent editions. Suggestions for improvement

are welcome.

Modification index

Versions Date Notes

MP4.30 06.2010 Corresponds to version 4.30 of MT8001 Management Termi-
nal Software.
In MP4.30, latest Catalyst V8 is supported, whereas Catalyst
V4 can no longer be used.

MP4.20 06.2009 Corresponds to version 4.20 of MT8001 Management Termi-
nal Software

MP4.15 09.2005 Corresponds to version 4.15 of MT8001 Management Termi-
nal Software

MP1.20 02.2004 Corresponds to version 1.20 of MT8001 Management Termi-
nal Software
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Introduction

1 Introduction

This is a guide to the localisation procedures for the MM8001 Management Terminal.
It provides the following information:

e General overview of the MT8001 localisation process.

e Guide for the localisation activities using Alchemy Catalyst.

e Details on localising XML-DB texts using XML editor.

e Instructions how to install the localised texts onto the MT8001 terminal.

1.1 What is new in MP4.30

4

The localisation process is still mostly based on the Catalyst tool, which can share a
glossary with the MMB8000 texts. The XML database, containing the MT8001 property
texts, can be localised with the same tool as MM8000, the XML-editor utility.

The subsystem model texts, which are used to start a new Composer configuration,
are the same as for MM800O. If a translation is available for MM8000, these texts
need not to be translated again.
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MT8001 localisation overview

2 MT8001 localisation overview

The following is a general overview of the MT8001 localisation process.

2.1 Localisation activity

What is localisation?
The MT8001 is distributed by SBT FS DMS with English texts. The activity required to
translate the English texts and to customize the default settings is called localisation.
The MMB8000 localisation process includes:

e Translation of MT8001 system texts and menus used in the terminal user inter-
face.

e Translation of MT8001 point property texts. These texts describe the states of
the point properties such as Alarm, Fault, and so on.

In this version, the Composer system texts cannot be translated, and the tools can
be used in English only.

2.2 Localisation toolkit

The MT8001 localisation is supported by a toolkit that is provided upon request. The
toolkit is distributed in the MT8001 CD and includes the files illustrated below:

MM8000 Localisation toolkit Contents

files

A | xml files XML-DB containing the MT8001 texts for point prop-
erties.

B |CatQS_ALL.exe Setup file for Catalyst 4 Quickship application. This
free-of-charge software can open .TTK data files and
translate texts.

C |MT8001 MP4.20 Def.TTK | Catalyst data files for MT8001, including texts in Eng-
lish. To start with the localisation procedure.

D |MT8001 XML Editor.exe XML editor application. It is used to localise the XML-
DB.

E |MMB8000 Build ZIP File.exe |Utility application that can create the LANG-xxx.ZIP
file required to install the localised texts.

F |MT8001 Language Installa- | Texts installation utility. It can update the Composer

tion.exe environments in order to include the texts for MT8001
system terminal and configurations templates.
Tab.1  Localisation Toolkit files

5
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MTB8001 localisation overview

2.3 Localisation process checklist

Items needed

A PC running a Windows edition that supports the language you want to translate
to. On the PC, check the locale setting in:

'Start > Control Panel &> Regional options - General tab/Windows locale’.

The PC must be compatible with the Composer tool (refer to the Composer Tech-
nical Manual).

Administrator username and password for the PC.

The MT8001 MP4.30 CD.

If you have any previous MT8001 localisation, contact the customer support to get
the existing texts imported into the new Catalyst project.

Localisation checklist

Log in as Windows administrator.
From the MT8001 CD, install Composer.

From the MT8001 CD, copy the Localisation Toolkit files on a new folder on the lo-
cal disk and remove the “Read-Only” attribute. Do not use the Toolkit files on a CD-
Rom.

Install Catalyst.

Localise the MT8001 system (see section 3).
In case of first localisation, create a new TTK file ‘(MM8000 MP 4.30 ENG.ttk’ =»
‘MM8000 MP 4.30 XXX.ttk’).

Extract MM8000 texts and generate DLL files1.

Localise the XML-DB texts (see section 4).

Create the LANG-xxx.ZIP file: use the “MM8000 Build ZIP File.exe” utility.
Install the language files: use the ‘MT8001 Language installation.exe’ utility.

In Composer, create a new project or run the “Localization update” on the MT8001
node of an existing project.

When the Composer project is ready, prepare and transfer the new database to
MT8001 applying the standard procedure (see MT8001 Installation, Configuration
and Commissioning guide).

Run the localised MT8001 and check the translated texts.

If required, correct the Catalyst or XML texts, then install them again for refining the
localisation.

When finished, save the final localised toolkit.

L A licensed Catalyst edition is required for exporting texts into DLLs See section 3.

6
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3 Translating System texts with Catalyst

3.1 What you need to start

To start the localisation of MT8001 system texts, the following is required:
e MTB8001 Default English Project (MT8000 4.30 Def.ttk).

For any released version of MT8001 a default English project is available in the lo-
calisation toolkit folder (or contact customer support).

e Catalyst software, which is discussed in the next section.

3.2 Catalyst Overview

Catalyst is an integrated translation environment by Alchemy Software
http://www.alchemysoftware.ie/. This application can extract (import) the text from ex-
ecutable files (e.g. EXE and DLL), and create a database file (TTK) that can be used
for a comfortable translation, assisted by a guided interface, and management tools.
When complete, translated text can be exported back to DLL and XML files, which can
be installed to get the localised software application.

Alchemy Catalyst

Catalyst is an integrated translation environment by Alchemy Software
(www.alchemysoftware.ie). This application can extract (import) the texts from EXE
and DLL files, and create a database file (TTK) that can be used for a comfortable
translation, assisted by a guided interface and management tools.

When ready, translated texts can then be exported back to DLL/EXE files, which can
be installed on a computer for testing the localised software application.

Catalyst editions
Catalyst is available in 4 different editions (see also the Catalyst product list in
http://www.alchemysoftware.ie/products/productline.html). These editions are:

e Catalyst Translator/Lite Edition (previously called Quickship)
Included in the MMB8000 localisation toolkit, this edition allows for translating texts,
but not for exporting them into DLL to test the localised software. In order to check
the results, it is necessary to ship the TTK files to FS DMS support and wait for the
exported DLL files.

- Catalyst Lite Edition can be downloaded free of charge at:
http://www.alchemysoftware.ie/translite.html

e Catalyst Translator/Pro
This edition is available for a moderate charge. This software enables you to trans-
late the TTK text databases, export texts into DLL, and test the localised MM800O.

e Catalyst Localiser
In addition to what is available in the Translator/Pro edition, the Localiser edition
provides more advanced tools for easy update of text versions, and more powerful
tools for task management.

e Catalyst Developer/Pro
This edition can provide additional tools for creating Quickship TTK databases.

7
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Translating System texts with Catalyst

mie

Important notes:
— Itis recommended to use the Catalyst Translator/Pro or Localiser edition. In fact,
using the Translator/Lite Edition will not permit you to immediately verify the local-

ised software, thus ending up in a longer and possibly more costly localisation proc-
ess.

— Note that Catalyst software requires a license code that can be requested via e-mail
to the Catalyst support. This is usually a fast procedure taking only one or two day’s
time.

— Catalyst V5 to or later, including latest V8, can be used. For each version, we rec-

ommend you installing latest Service Releases available at
www.alchemysoftware.ie.

Training on Catalyst

Using catalyst software is quite simple. Before using it extensively however, we rec-
ommend that you run some training sessions. These are available on the Internet at:
http://www.alchemysoftware.ie/tutorials/index.html.

3.2.1 Basic Catalyst instructions

For both TTK files (system texts and configuration tool models, see above), proceed
as follows:

Create your own TTK files

In Catalyst, open (File = Open) the original TTK file (“...ENG.ttk") and saves it (File
- Save as) in the same folder with a new name. We recommend using the same
name, and only replacing the ENG code with your own language code (e.g.: FRE for
French, SWE for Swedish, etc.). See Fig. 1.

The MM8000 TTK files are provided as Catalyst V5 data format. When using the Save
As command, please do not change the format version of the files.

8

:_-gnlchemy Catalyst 4.0 QuickShip Edition - [MM8000 MP 2.31 E

uﬁ Wiew Object Tools ‘Window Help

= | CPEn, Chrl+0 English |
5 B Close Ctrl+F4 o
ki
= [ save Chel+5
E COmpress. ..
L[EE Import Section ., CEr+I
t[Ea Expott Section. .. Chrl+H

1 MMS000 MP 2,31 EMG. ke
2MTE001 R1.10 Eng.ttk

3 MM3000 MP 2.3 - Subsystem To
4 MM3000 MP 2.2 - Subsystem To

Save As |
Savein: | ‘-d MMBDOO MP 2.31 - Localization Taak ¥ | 4= [&] £F E5-

Eiat
Default Project

Exit il Files
MMSDDD MP 2,31 - Subsystem Tools ENG, btk
MMBUUD MP 2,31 EMG.tk

File: narme: IMMSDDD MP 2,37 SWiE| Save I
Save as hype: ITransIation Toolkit [*ttk) j Cancel |

Fig.1  Save the renamed TTK project
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i

Depending on the Catalyst version you are using, the Catalyst user interface may or
may not exactly appear as illustrated in the snapshot pictures below.

Set target language
If you are running the Licensed Catalyst edition, then select your target language: (see

Fig. 2). This is not required in the Quickship edition.
f_’;_.'.nlchemy Catalyst 4.0 Quickship Edition - [MM8000 MP 2.2 FRE.ktk]

[ 1 Fle Edit WYiew Object Tools window Help

M| | ~| 12|53 [Engish riedstes) ~[[French Btandard) =l El
Al & 5 BJA =l «|»| &% al B[E % [ |

Fig. 2  Target language setting

1

Navigation tree

Open the navigation tree as indicated in Fig. 3.
f:"_‘l:_.'.nlchemy Catalyst 4.0 Quickship Edition - [MM8000 MP 2.2 FRE.ttk]

(1 File Edit W¥ew oObject Tools Window Help

S| || 12a]fa| [Eraion Uneastates | EMiting field we|| 3]s
Blal & 2|5 Bla =[5|| «[»]| @[%| & % %14 | [=
. " S

Fig. 3  Open the navigation tree

This results in a tree view being displayed on the left hand side (see Fig. 4), showing a
number of resource groups. The ones indicated by the priority sign (a red triangle A )
have to be translated.

= Texts marked with the symbol @ (reserved) must not be localised, please ignore
them. Note also that the symbol may be removed and the associated text (or value)
modified; you should not do that!

= Texts marked with the symbol & (locked) must not be localised either, please ig-
nore them. Note also that the symbol may be removed and the associated text (or
value) modified; you should not do that!

9
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':f;.-'nlchenw Catalyst 4.0
1 File Edit Wew Object Tools Window Help

Quickship Edition - [MMS00D

S| o | 12| 8a| [Engishniedstaes)

Bla| & )&

BlA E|E| «[»

x|

=
P =HE]

@

=

=0 MmMB0n

Client
PointDialogR esources. dil
E Bitmap
E Dialag
LE] 3200 - Propriétés du p
E StringT able

AR 33 |

e

&

H-
H-
++
]
5
el

[

&

N~ @@a
T3l

Fig.

Translating text string

aBE 12

BB 414

L EBE B15

E [elaly]

E Wersion

B9 Dialogirit
EBRRezources.dl
ETRepRes.dl
ETResources.dl

Tree view in Catalyst

S

Select the group in the tree, and translate the individual text strings that display on the
right hand side of the screen (see Fig. 5 below).

1=
i Original Text:
M B000 Sent at
Client
a F'olrl;tili)rﬂ;gﬂesources.d Tran&l’ated Test
& a Dislog Ervoyé e
LED 3200 - Propridtés c
] a StingTable
Bz ég String 1D | Translated |Drigina|
Cabe % 12 128 Q ----- Colurmn descriptions - e Column descr
| gEg ;14 129 @ D énamination Custom Mame
| sz ‘faﬂs 130 » D D
[}a IE:Un 131 % Condition Condition
. 132 @ Changé le: Changed at
[}a anarsu:n . 133 @ Commande Command
[}a Dilaglrit 134 W Envoyé e Sent at
EBHEBSDL’"CBS' di 135 @ Compte rendu Feedback
Bitmap 136 % Mom technique Technical narne
Menu 137 @ Type Type
Dialog 138 @ Sous-type Sub-type
StiingT able 139 % Discipline Dizcipling
Wersion 140 @ Souz-discipline Sub-dizcipline
ETRepRes.di 141 @ Mam Cauze point name
ETResources.dl 142 @ Cauze Cauze

Fig.5  Translating text strings
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How to use the spelling checker
1. Choose Tools — Options from the Catalyst menu and then the General tab.

2. Select your language under the Dictionary dropdown.
Note: You should also select Perform auto checking and Hotkey aware, as

these options will notify you if you misspell a word while you are working, and will
ignore ampersands (&) when spellchecking.

3. Select OK.

2 To quickly correct any misspellings while translating, click Edit - QuickS-
pell, or press F3 to display a list of suggested corrections. Double-click a
correction to replace the misspelling with the selected correction.

3 To check the spelling of a text string, click Edit— Spell Check, or press F4.

How to use atechnical glossary
1. Choose Tools — Options — General from the menu.

2. Select the Glossary tab within the Options property sheet.

3. Check the box beside Glossary 1 and select the glossary you wish to use.

Note: You can attach two glossaries, and you have the option to suggest from the
TTK you are currently working in. You also have the option to select Update glos-
sary file with (TTK) translations on close of (TTK) file. This will add new transla-
tions in your TTK to your glossary file each time you close the TTK.
While translating or editing, to ensure correct and consistent terminology for your
translations, click Edit — Glossary, or press F2 to look up recommended translation
suggestions while translating or editing text strings in objects

Localisation of menus and dialogs

Menus and dialog windows can be translated in WYSIWYG mode (What You See Is
What You Get). The menu and the windows display exactly as they would appear in
the software application when viewed by a user (and can be adjusted). Just press F7
or the button shown in Error! Reference source not found..

Toggle Mormal A SIAY G-

ﬂIFrench [Standard) j ﬂ a- EE ﬂ M e
SEEC O (O —

T T T T T T T T T 2 3P E 57 P8 EL TIPS E

fomeres >

o

1]
i
+
+
+
+
-
5, 4
+

|' Types d'événements

[~ Tous [~ Evénement opérateur [~ Evénement automatique

R A RS LR LU,

Fig.6  Using WYSIWYG mode

How to enable automatic translation (replica option)
1. Choose Tools — Options - CATALYST Experts from the menu.
2. Select the Replica tab within the Expert Options property sheet.

3. Check the box beside Enable Replication and select Interactive Replication.

Note: Whenever you translate a text, the software will check whether the same
string is present in another position and propose a multiple translation.
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3.2.2 Exporting Catalyst translated texts
This step is required to extract the localised texts and store them in the runtime DLL
files replacing the original English texts.
Note that only the licensed editions of Catalyst are enabled to extract texts and updat-
ing DLL files
The charged editions of Catalyst also allow you to export the translated texts into the
run-time DLL files. To export texts, do the following:
1. Select the top node on the tree.
2. Choose File — Extract section (or Extract file, depending on the Catalyst version).
3. In the browsing window that appears, select the destination folder of the files.
The destination directory of MT800L1 file should be the localisation toolkit folder.
3.3 MT8001 Catalyst Project Structure
The default MT8001 project will be presented as shown in Fig. 7. It includes 6747
word to translate in two sections: 1059 words for the MT8001 runtime texts and the
rest for the MT8001 Subsystem Tool texts.
©4 Alchemy Catalyst 5.03 Translator Edition - [MT8000 R3.15 Eng.ttk]
[ File ¥iew Object Tools ‘Window Help
A= HE W B E e |[ingshiniedsaes) 7]|French HlEmgEe |
e | I =) Start Page Stat\slics|
|7 15|52 [moriten = 225 B0
RN (9] GuartoRes.DLL
=1 MTBE000R3.15 | 391 124
MTEODT SubSpstem Tools #[8] SintonyRes.DLL
Syztem M3 120
Undate |F"le &.Gas s;bs_\:stems l gg s Gd
. D";;'Z:;;Sf::m ®[8] CFo000systemRes.dl
i‘g| MTB001 Run-time texts 34 2
Pseudo MT8001RES409.dI #[8] CFO000Res.DLL
Bitmap 237 41
= StingT able #[9] DMS7000Res.DLL
II?E:‘?_ ersion 128 - 17
1059 10469
@ MT8001RES409.dll
1059 1059
Resource type Words
Entire Report 6747
Resource File 6747
TEMFLATE 1]
Bitmap i}
Dialog 1760
StringTahle 4831
Icon 1]
Dialoglnit 136
241 1]
u | . |;| Warsion 20
Fig. 7 MT8001 Catalyst Project report
i If you have translated the Catalyst texts for MM8000, then you already have the Sub-
system Tools texts available. Please contact customer support to have the translation
imported into the MT8001 Catalyst project.
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4 Translating XML texts with the XML-Editor
4.1 What you need to start

To start the localisation of MT8001 XML texts, the following is required:
e MTB8001 toolkit copied on the local disk.
e Composer environment installed.

4.2 XML-Editor Overview

With the XML Editor, you can open the MT8001 XML files and modify the text informa-
tion and the symbol association.

4.2.1 Launching the editor

Starting XML Editor for localisation

You start the XML Editor launching ‘MT8001 XML Editor.exe’ from the Localisation
toolkit folder (see Tab.1 at p. 5).

Note: the program must run under an account with administration rights.

4.2.2 Working with the editor

XML Editor menu
The XML Editor provides a Windows-standard interface. The main menu and the tool-
bar are illustrated in Fig. 8.

MTB001.xle - XMLEditor
File Edit “iew Help
W B %
Wirthyal Pbﬂ\ys | Propiest action F'rn:npertiesl [ ata Paints
Open  Save Expand Collapse HNew About

Fig. 8 XML Editor interface
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Translating XML texts with the XML-Editor

The command list in the XML Editor menu includes:

Selection ... Toolbar | Command
File > Open = Open XML-DB
Save I Save information into XML-DB
Import old XML - Import the localised XML-DB from a previous
release. That will be automatically updated to
latest release.
New localised lan- - Copy the original XML-DB into a new database,
guage thus creating a new language.
Backup - Compress and save the XML-DB
Restore - Uncompress and load the XML-DB
Exit - Quit XML Editor
Edit > Expand = Expand the sub-tree whose root is the selected
node
Collapse o Collapse the sub-tree whose root is the selected
node
Replace - Replace a text through the entire database
View = Toolbar - Enable the toolbar, just below the menu.
Help > About ? Show the ‘About’ window
Data view

When used for MT8001, the XML Editor only includes one data view, organised in four
active columns, shown in white background (Fig. 9). An additional space is available
on the right for general information.

MT8001.xle - XMLEditor

File Edit Wiew Help

==

MTE00 |
|
Marme Original [English) | ozalized [previous verzsion) | ozalized [curment werzion)
(= B Project (MT2001)
- 201301 FT2007T Manitaring Station
B 300101 [CSE Guarto
B 350001 CZ10
B 350101 hk. 7022
[+ 350401 CC440
B 350501 CC11EPS
B 350901 CK11EPS
F# 351001 STT11CPU
B 351101 SE11
B 351501 DM57000
B 351703 MWEEZ 20
B 351901 CCED
B 352001 Sintory 51410
- 352111 CF9003
B 352501 CE11EP?
[ 352601 CC11EP?
Fig. 9 XML Editor tabs

The four columns contain:
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Translating XML texts with the XML-Editor

Title Contents

Name This column lists the text items (object properties) and, for each of them, its condi-
tions and commands.

In this column, a special icon (&) shows up next to the name when the value has not
been modified yet; then, after the translation, a new icon is used (#) to indicate that
a final revision is required.

The icon can be cleared by right clicking the line, and then selecting the command

‘lcon reset’.
Original Here the original property text in English is shown. This text cannot be edited.
(English) In case of Data Points, the original icon number is shown.
Localised This column is only used when a previous XML-DB release is imported. In this case,
(previous version) the previous text (or icon number) is reported here. This value cannot be edited and

it is shown for reference only.

Localised This column contains the localised texts (or icons) that, initially in English, are pro-
(current version) gressively translated. You can edit the text field in two ways:

1) Individually: select the line and then the field in this column (use a single click). At
that point, you can replace or modify the field and then press Enter to confirm (see
Fig. 10).

2) Sequentially: select the line (first mouse click) and then click on the editing field
just below the menu and the toolbar (see Fig. 11).

At that point, you can replace or modify the field and then press Enter to confirm. The
program automatically moves to the next line and select the text field for editing (in
certain cases, you may have to press Enter again to step ahead to next field).
Localised value is shown in green colour instead of black.

] INIUSIoN 3ecton INIUSION SECU0n
[l 30 Burglary zone EBurglary zone
- SymiD 10306 10308
= LPs
& 77 Desc Desc
A T024 Alarm [#armef |
-4 SymiD 1 —

[ A Causes
[+ & LPCrds

[ & EVPs
[+ & 1032 Test Test
[+ & 1036 Mot Ready Mot Ready
N Flierrwman tad Tiinr e tard

Fig. 10  Individual text editing

MT8001.xle - XMLEditor

File Edit View Help

IR ETES Editing field
MT8001 |
— " ]
A:quitleuc
Mame Original (English] Localized [previous wersion] Localized [curent version]
BT & Causes
= ] Marmal Mormal
- A SymiD 7E5 7B5
2 Alarmn Alarme
-k SymlD 25 25
g Alarm Alarme
b SymlD 25 25
Alarm Alarmne
: SymlD 25 25
Acknowledge Acquitter
SymlD 1] 1]
; ActionDesc Acknowledge Acknowledge
7 Feset Feset
& EVPs
B & 1032 Test Test
[ & 1036 Mot Ready Mot Ready
Bl & 1033 Disconnected Disconnected

Fig. 11  Sequential text editing
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Translating XML texts with the XML-Editor

4.2.3 Creating a new language

When starting a new localisation, you first have to copy the original XML-DB into a
new database. Use the ‘New localised language’ command and, when prompted, con-
firm it.

This command results in the ‘Localised (current version)’ column being populated by
texts, which are initially the same as the original English. Also, all items are marked
with the ‘not-translated-yet’ sign (&). See Fig. 12.

MMB000.xle - XMLEditor
|Fi|e Edit View Help

CIpen. .. Chrl+0
Save Chrl+5

hperties  Data Points
Import 2ld xRl

Mew localized language

Backup
Restore

Exit

Fig. 12  Select ‘New localised language’ to start a new localisation

4.2.4 Translating Properties texts

The property texts are included in three tabs of the user interface (p.14): Virtual Prop-
erties, Physical Properties, and Transaction Properties.

Required texts

The XML file structure includes several parts. For the localisation purposes, only the
“Causes” and “LPCmds” sections are important and must be translated, whereas other
texts can be ignored. See Fig. 13.

Main Supply Fault M ain Supply Fault
E03 E03

Mormal Mormale

Active Active
Power Fault [érangement alimentation
Power Fault [érangement alimentation
Power Fault [iérangement alimentation

a a

Fig. 13 Example of “Causes” text

Translation checklist
To translate texts, you have to:

1. Select a group in the Name column.

2. Expand the sub-tree to show the “Cause" texts.

3. Select the first text clicking on the corresponding line.
4

. Press F2 or click the text in the ‘Localised (current version)’ column (individual edit-
ing, Fig. 10)
- or -
click the editing field (sequential editing, Fig. 11).

5. Translate the text and confirm with Enter.

6. Translate all “Cause” texts, repeating steps 3 to 5.
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Translating XML texts with the XML-Editor
7. Translate all “LPCmds” texts, repeating steps 3 to 5.

8. Translate all groups, repeating the steps above.

The

Replace command

Some of the XML-DB fields actually contain the very same texts (e.g. Alarm, Fault,
etc.). Therefore, the global replacement function offers a powerful way to translate the
entire database quickly and consistently.

Just start the command ‘Edit > Replace’ and then fill in the window that shows up
(Fig. 14). You can first try a single substitution (Replace) and then operate globally
(Replace All).
B 7025 Fi k5 hread :
B 703 PointS erver degueue thread guantum
= A 703 Foinerver hesk tizad prirly Find what:  [#lam Repice |
:: e T T i Replacz vitt: [Plime Replace Al |
' :: ;gi; g‘::: II;::I‘t ¥ Match whole word only ol |
[ 7043 General Alaim IV Match case
B 7044 Open cover
- 7045 Event server threads Alam
: A SymiD 603 [SIE]
B Causes
H -4 0 Warmal Marmal
-1 Active Active
-k 2 Alarm Alaime
: - 3 Alarmn Alarmne
- 4 Alarm Alame
Fig. 14  Filling in the Replace window

In the list, the MT8001 properties are repeated for each object and each type of con-
trol unit.
This can give you the maximum flexibility in the way you want to translate the status

and

command texts for each object.

On the other hand, this approach creates large amount of texts to translate. Here are
some recommendations about how to speed up the activity:

1)
2)

3)

4)

5)

6)

No “Undo” function is provided, therefore backup the XML folder in case you need
to correct any mistakes.

Use the “Replace” function as much as possible in order to quickly translate the
same descriptions and be consistent across the entire file.

When you can select the “Replace all” option for automatic replacement, check
the report that appears on the screen: there you can verify whether the affected
properties are the ones you really intended to modify.

In case of doubt, go for the individual replacement that let you check the substitu-
tions one by one.

Pay attention to the English descriptions such as On, Off, Include, Exclude, which
occurs in quite a few cases and may need to be translated in different ways de-
pending on the application.

If you intend to use the MT8001 in a larger system with MM8000, consider the
need of consistency of the texts in the two products. You can check the MM8000
properties text in the “Ips.xml” file of the MM8000 localised Kit.
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Translating XML texts with the XML-Editor

4.25 Localising symbols of objects and property
In certain cases it may be necessary to modify the symbols associated to the MT8001
objects and properties. The associated symbol is defined by the number indicated in
the SymiD line.
E-d Project [MT8001]
=& 20301 b4 TE007 Moritoring Station MT8001 Monitoring Station
=& 300101 CSE Guarto CSE Guarto
- A NTs
__C56 Guarto __C56 Guarto
A 256 Area Area
- 257 D oor monitor zone Door monitar zone
B A 258 Teminal main CTEM / CTEC Terminal main CTEM / CTEC
[+ & PRY Tearminal Asiliar CT4-NR 4 NR Trrminal ausiliare CT4-05 A TR
Fig. 15  Setting a new symbol number
A mouse click on the symbol number in the localised column results in a selection
window being displayed (Fig. 16). Select the new symbol and click OK, or click Cancel
to leave with no changes.
Icon Selection x|
> s = = ~ ~ 0K |
Jﬁﬂ JK’ > JK’ JK“ o
10300 1 USE:"I“ 1 :(U“EIU 1 ‘I”Untll] 1 ?ZBUEI 1!\:3%[;! 1‘l\:3BUET| ﬂl
. gy s Be N RD N
WS 1] —_ —
11303 11400 114M 11402 11402 11404 11405
o g BE§ O
11407 11408 11409 11500 11600 11800 11801
02 M (e Z W
11803 11804 11808 11901 11902 11902
0 & ' ok = B
11305 11806 11907 11908 11903 11910 11911
& omx LN m=w N B j
12000 12001 12002 12004 12005 12006 =
Fig. 16  Selecting a new symbol
Symbol localisation checklist
1. Select a group in the Name column.
2. Expand the sub-tree and select the object or property you want to modify.
3. Select the line named ‘SymID’.
4. Click on the value in the ‘Localised (current version)’ column.
5. Select the new icon (Fig. 16).
6. Repeating the steps above for any other symbol you want to change.
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Translating XML texts with the XML-Editor

426 Save localised XML-DB and leave editor

You can close the XML editor by selecting File - Exit. There is no risk you can lose
the data you just entered: upon terminating the program, a window displays like the
one shown in Fig. 17.

If you want to save the changes to the XML-DB, click ‘Yes’; instead, if you want to dis-
card the latest modifications, select ‘No’. Clicking ‘Cancel’ results in aborting the pro-
gram termination and in the editor remaining active.

XMLEditor - |

Mo Cancel

Fig. 17 Save XML-DB files
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5 Installing the localised texts

5.1 What you need to start

To start the localisation of MT8001 XML texts, the following is required:
e Catalyst texts translated and then extracted in to the toolkit folder.

e XML texts translated.

e Composer environment installed.

5.2 Preparing the new text environment

20

Once both the Catalyst and XML texts are translated, you can proceed to the installa-
tion of texts. This procedure includes:

e Creating a compressed file with the complete set of files.
e |Installing the compressed files.
e Transferring the files to the MT8001 terminal unit.

Creating the text ZIP file

Using the “MM8000 Build ZIP File.exe” utility, available in the localisation toolkit, you
can create e compressed file that contain all text files and is named: LANG-xxx:ZIP,
where “xxx” indicates the language (e.g. FRE for French).

Installing texts

Starting from the compressed text file, the “Language Installation” utility can update
the Composer environment in order to:

— Install the new system texts for MT8001

— Update the subsystem templates for MT8001 projects

Updating texts on an existing MT8001 project
In Composer, new MT8001 projects automatically include the new texts. Instead, the
current project requires to be updated. Just proceed as follows:

1. Setthe Debug key of Composer using the “ST_DebugYes.reg” file placed in
\MT8001\Utilities\Reg’ path.

Start Composer.

Open the MT8001 project.

In the structure tree on the left, select the MT8001 node.
In the working pane on the right, select the Node tab.
Click the “Localization Update” button.

Wait for the procedure to complete.

© N o 0o M w0 D

On the same Node tab, click the “Update Project” (to overwrite the XML of your
project with the new localised files).

9. Wait for the procedure to complete.

10.Remove the debug option using the file “ST_DebugNo.reg”.
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Installing the localised texts
Transferring texts
The MT8001 will be updated with the new texts when the new configuration is trans-
ferred to the terminal. The standard MT8001 preparation and transferring procedure
can be applied; please refer to the MT8001 Installation, Configuration and Commis-
sioning guide.
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